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AutoCAD Tutorial – Part 2:  Draw the sectional view of the 
.       mechanical part, dimension and plot 
.      the drawing 
Introduction 

 In this tutorial you will learn how to open the existing drawing, make cross 
section, hatch it, dimension the drawing and plot it. 

Starting AutoCAD with an Existing Drawing 

 

Log on to the computer using your university login name and password.  
To load a drawing, start Windows Explorer and select the appropriate Drive and 
Directory. Once Explorer is showing the correct directory then double-click on 
your CADTutorial1.dwg drawing. 

 

If you can't find your drawing (in Windows Explorer) then press F5 (function 
key 5), this tells Explorer to update the directory display; if you still can't find 
your drawing then perhaps you saved the drawing in some other directory - load 
AutoCAD and then select the File menu, at the bottom of the File menu is a list 
of recently opened drawings, select your drawing from the list. 

Draw the cross section line 

 Set the CENTRE layer to be the current layer. 

Object snap and object 
track 

Type OSNAP  to start Object snap dialog box. Click on both ‘Object snap 
ON’ and ‘Object Snap Tracking On’ boxes. Close the dialog box pressing OK. 
Same function can be performed by pressing F3 for Object Snap and F11 for 
Object Snap Tracking. 

Orthogonal movements 
of the crosshair 

Press F8 to set ORTHO on. Watch the command line to confirm that. 
Select “SECTION” as the current layer. 

Make the cross section 
line using polyline 

command  

Type PLINE  to start polyline or type on the polyline icon , then snap the 
crosshair on the top of the centre line on the right threaded hole until you see 
yellow triangle. Move upwards and click with left mouse button at about 10 
mm above the end of the centre line. Your drawing should be like this: 

 
Then move crosshair straight down until it ‘snap tracks’ with the short 
horizontal line and click left mouse. The first part of the cross section line is 
made. Now move the crosshair to the left and snap track on the centre line of 
the right hole in the bottom part of the drawing. Again click the left mouse 
button to make a line. Finally, move down to pass the bottom horizontal line 
and click the mouse button. Terminate polyline by pressing .  
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You should have the 
following drawing 

  

Insert the Cross section arrow and letter indications 

 Position the cursor on any toolbar area and click the right mouse button. From 
the dialog box select Dimension to display the dimensioning toolbar. 

Change current layer to 
TEXT layer Open Layer manager, and make TEXT layer current. 

Make Leader 

Select Dimension – Leader from the drop down menu or the Leader icon from 
the dimension toolbar or alternatively type LEADER . 

Select snap to nearest from the snap toolbar  and click on the cross section 
line above the threaded hole. Move to the right and select the second point on 
the leader. Type  to terminate the next point selection. Type in 4  for the text 
width and then type in the annotation text A . Repeat  to terminate the 
command. 

Copy existing leader 

Type CO  or COPY  or select the copy icon from the Modify toolbar. Select 
the leader and annotation you have just made. Press  to terminate selection. 
Press on the intersection between the leader and the section line to select the 
base point. 

Select   icon from the snap toolbar and then click on the section near to the 
bottom of it. You have copied the leader and the annotation. 

 

 
 



ME1105 – CAD Tutorial 2 3 Prepared by A.Kovacevic 

Draw Section A-A 
Draw vertical 

construction lines 
Make layer ‘Thin lines’ current 
Type L  an then: 
270,95  
0,120  and  to terminate the line command  

Use offset command to 
make more construction 

lines  

Select OFFSET icon or type O .  
Type 5  and then select the last drawn vertical construction line. Move the 
crosshair to the right, click to confirm and then terminate command with . 
Repeat the last command 6 times each time selecting the line that you last 
made, first for 10 mm, then for 3 mm, the for 1 mm, then for 14 mm and finally 
for 22 mm. Drawing should look like: 

 

 
Draw horizontal 

construction lines 
Select LINE icon or type L , Then make lines as on the following figure. Do 
not forget to have OSNAP on. Do not forget to press   

 

 
Using the polyline 

command draw the 
outer line of the cross 

section. 

Set DRAW layer as the current layer. 
Type LINE  or select the polyline icon. Start making lines from the top left 
corner. REMEMBER: OSNAP should be ON. 

 

 
Change current layer to Set CENTRE current layer.  
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CENTRE Draw the centreline of the hole in the cross sectional view, as shown in the 
figure. 

Copy threaded hole to the cross sectional view 
Copy the threaded hole 

on the section view 
Type CO  or select the copy icon from the modify menu.  
Select the right threaded hole on the front view and set the base point as the 
intersection of the centreline and the top line (As shown in the figure). 

 

 
Select the intersection between the fifth vertical construction line from the left 
and the top construction line as the second displacement point. Click on the left 
mouse button to confirm. 

 

 

Change the LAYER for 
the drilled hole lines 

Select the lines of the drilled hole as shown in the figure and select Modify – 
Properties. In the property window Change layer to DRAW by clicking on the 
right side of the box next to text ‘Layer’. Click X on the right top of the 
property window to close that window. 

 

 
Delete all construction 

lines  
Select ERASE button from the Modify panel or type E  or ERASE . 
Select all horizontal construction lines by clicking on them individually. 
Press  to confirm the command. 
 
An alternate way to delete is to click on the object to be deleted and then press 
the keyboard's "Delete" key. Click on the line in the same place and press 
"Delete". 

Turn Layer ‘Thin lines’ 
off 

Open Layer Property Manager. Click on the ‘bulb’ icon next to the layer Thin 
Lines. The bulb will change the colour and the turn layer will be turned off. 
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Make fillets 
Select the fillet 

command  
 

The Fillet command is 
exceptionally useful. It 

basically extends two 
lines until they meet, 

and optionally, inserts a 
curve where the lines 

join 

Select FILLET icon or type F  or FILLET  . 
Type R  and then enter the radius value 2 . 
Type T  for Trim options.  
If you pres T  again, then the fillet command will trim the lines after filleting 
between them. If you select N  option, then trim will not be performed to the 
line. Let’s try. 
Type T . Select these two lines 

                              This will be the result: 

Repeat the last command by pressing .                      
Press T  and then N .Select the following lines.   
The result is as follows: 

 

            
Repeat the same command for these two lines:

Use trim command 

 

Use trim to clean up the unwanted part of the line: 
Type TRIM . Select the fillet and type . Click on the unwanted part of the 
line to clean it. 
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This is how your 
drawing looks now. 

 

Hatching and writing text 

Save icon  Before you do hatching it might a good idea to save your drawing (select save 
or press Ctrl-S). 

 

Hatch icon  

Select a layer called HATCH, and make it current, and then select hatch from 
the Draw panel, make sure the pattern type is “Predefined”, and set the pattern 
to ANSI31, set the scale to 1, select “Pick Points”, pick inside the areas that you 
want to hatch, press to end the selection process, pick “OK”. AutoCAD 
should draw lots of lines, filling-in the cross sectional area. 
Note: you should at least once click on all internal areas that have to be hatched. 
Do not forget area between hidden and solid lines that represent thread. 

The final result should 
look like 

 

Finally, write text  

Select TEXT icon from the Text panel on Annotate ribbon or type MTEXT
Specify the first and the opposite corner of the text box and elect the rectangle, 
Type in: ‘SECTION A-A’ and confirm by pressing OK. Adjust font or text 
size if appropriate. Use move command to move the text box to the desired 
position or properties to align the text within the textbox or to alter the text size 
or layer. 

 

WELL DONE! You have made a 2D model! 
What you need to do now is to dimension the drawing and to make it plot. 

 
 

Editing Title block 
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Change to the Paper 
space Press ‘CITY A3 Layout’ To change to the paper space. 

Enter the title block 
values Double click to the title block. The dialog box will open 

 

 

 Scroll up and down to change Values for each of the title block entries. Close 
the dialog box by pressing OK. 

 
On the CITY A3 Layout screen, you will see the titleblock, but not the 
drawing. To see the drawing, you must "cut" a window or VIEWPORT in the 
Paper of the Paper Space so the drawing will show through from Model Space. 

Inserting Viewport 

Make a viewport 

There are three ways to access this command, by typing vports at a 
Command: prompt, selecting Viewports on the View ribbon, or using the 
Viewports toolbar. There are more options available when you type vports at 
a Command: prompt than with the other methods of accessing this command. 

To use the Viewports toolbar, you must first place the toolbar on the 
AutoCAD screen. This toolbar can be displayed on the screen by locating 
Toolbars... on the Tools menu. When the Toolbar dialogue box appears, 
scroll down to the Viewports listing and click on the check box next to its 
name. Click on Close to exit the Toolbar dialogue box. The Viewports tool 
bar will appear on the AutoCAD screen. Move the toolbar by grabbing it in the 
area by its name and dragging it into the area to the top or side of the screen 
where other toolbars are located.  

With the Viewport toolbar visible, click on the single viewport button to 
select Single viewport. AutoCAD will return you to the CITY A3 Layout 
screen. The prompt will ask you to pick the first corner of the viewport. Use the 
Endpoint or Intersection Osnap and select the upper left corner of the 
titleblock. When it ask you a second corner, use an Osnap again to select the 
intersection of the title areas that contains the heading TITLE: and the 
Right vertical line that forms the titleblock and press Enter to exit the Vport 
command. See the following figure The drawing should show inside the 
titleblock.  
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If the scale is not set to a standard one, you have to change it. This will change 
the size of the drawing to a STANDARD SCALE. There are certain acceptable 
scales that can be used. NEVER use the scale to fit option. For this drawing, 
you need to scale the drawing to 1:1 before you print it. To scale the drawing 
select the drawing border,then  you have one of two options: select a scale 
factor on the Viewports toolbar or use Zoom XP.  
Note: To change scale or other parameters of an object you can also use 
properties. To do that, select object, right click on it and click on properties. 

 

You now should have the following drawing. If your drawing does not look 
exactly like this one, you have either missed some steps or made some 
mistakes. To correct them, return to the model space by pressing ‘Model’ in the 
menu or by typing MODEL . 

Dimensioning the drawing 
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To start dimensioning 
you need to turn on the 

dimension toolbar. O do 
that, right click on any 

toolbar area and tick 
Dimension. 

Select layer ‘DIM’ and make it current layer. 

You will find dimensioning commands in the Annotate ribbon. Alternatively 
you may wish to open the dimensioning toolbar and place it on the AutoCAD 
window. Remember you will find this under Toolbars... on the Tools 
menu. 

 

 

To add dimensions efficiently, you should create a dimensioning style. 
Dimension styles can simplify dimensioning by predefining certain dimension 
formats. The dimension Style... dialogue box is available under the Dimension 
Menu as Style... or by clicking on the Style button on the Dimension 
toolbar or panel. 
However, in the template that you are using, dimension styles have already 
been arranged in the ISO-25 dimension style. 

Start with linear 
dimension 

 

Check if the current layer is set to DIM. 
Select Linear dimension from the dimension toolbar  or type DIMLIN . 
Start dimensioning from the bottom left corner. Be sure that OSNAP is ON. 
Pick bottom left corner, then the next intersection on right. Move cursor down 
for approximately 10 mm and left click mouse. 

Baseline dimension 

 

Use baseline dimension to specify dimensions from the same origin. Select  
or type DIMBASE . Click the centre of the first hole on the right. 
Then click the bottom right corner.  Press  to terminate command. 

 
Combining Linear dimensioning and baseline dimensioning make all vertical 
and horizontal dimensions as shown in the next figure 

Move command 

If in the drawing some element of a shown 2D model are not in the right place, 
you can always move them by using command MOVE. To use it, you need to 
switch to the model space. Command move behaves similarly to copy 
command except it deletes the original object when you copy it. 

Continue dimensioning 

 

Type DIMLIN  for linear dimensioning and dimension the first horizontal 
distance on the left top of the sectional view. Terminate the command with . 

Type DIMCONT  or select  to continue with the dimensioning of the 
distance to the centre of the threaded hole. Terminate that command by pressing 

. 
Use DIMLIN  and DIMBASE  to finish the rest of linear dimensioning. 

Use radius dimension 

 

To dimension radius type DIMRAD  or select  icon. Click on the radius 
and position the dimension line conveniently.  

Use diameter dimension 

 

To dimension diameter type DIMDIA  or select  icon. Click on the 
diameter that you want to dimension and set dimension line conveniently.  

Annotation dimension 

 
 

Note: if you want to 
define diameter type 

%%c 
If you want to specify 

deg, type %%d 

Turn ORTHO off by clicking on the mouse or pressing F8. 
To set annotation dimension type QLEADER  or click  icon. Select the 
point where you want to position the arrow and click to the convenient position. 
Continue pressing  until asked: Enter the first line of annotation text: Then 
enter required text: 2x%%c10.2x22 depth M12x1.675x6Hx15 . Terminate 
command with . 
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You now have 
completed 

dimensioning. Your 
drawing should look like 

this  

Geometric tolerance To specify DATUM or Geometric tolerance use  icon. 

 

CONGRATULATIONS! 
If you have drawing similar to the above figure you have successfully finished 

CAD-2 Tutorial. You need only to print your drawing. 
DO NOT FORGET TO  SAVE YOUR WORK. 

Finishing up  

 
That's all for CAD tutorial two! Save your drawing (press Ctrl-S) and then exit 
AutoCAD (select File - Exit). 
Remember to log off before leaving. 

 


